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REGLAMENTO PARA USO DE LABORATORIOS Y TALLERES 
 

OBJETIVOS 
 

● Establecer las condiciones generales y las reglas básicas de conducta asociadas al funcionamiento 
y al uso de los laboratorios y talleres de la Escuela de Ciencias de la Ingeniería y Tecnología 
(ECITEC). 

● Establecer lineamientos para la seguridad de los usuarios del laboratorio o taller, en el manejo 
adecuado de los equipos y materiales que allí se encuentren. 

● Prestar un eficiente servicio a los usuarios, mediante el adecuado funcionamiento del equipo e 
instalaciones. 

 
CAPITULO I 

 
DISPOSICIONES GENERALES 

 
Artículo 1.- El presente reglamento es de observancia para todos los alumnos, y personal de Escuela 
de Ciencias de la Ingeniería y Tecnología. 
Artículo 2.- Son sujetos de este reglamento todos los estudiantes que se encuentren inscritos como 
alumnos en cualquiera de sus programas educativos, docentes de tiempo completo y asignatura, 
técnicos académicos, invitados, así como personal administrativo de la “Escuela de Ciencias de la 
Ingeniería y Tecnología.” 
Artículo 3.- La aplicación y vigilancia del presente reglamento compete al director de la Escuela de 
Ciencias de la Ingeniería y Tecnología, al subdirector, Administrador y al Coordinador de Programa 
Educativo, Coordinador de Tronco Común de Ingeniería, Arquitectura y Diseño. 
Artículo 4.- Para los efectos de este reglamento se entiende por: 

 
I. ” ECITEC”, a la Escuela de Ciencias de la Ingeniería y Tecnología. 
II. Director, al director del ECITEC; 
III. Subdirector, al Subdirector Académico; 
IV. Administrador, al Administrador 
IV. Laboratorio/Taller, al área destinada para efectuar prácticas, y actividades referentes a las 
carreras impartidas en el ECITEC; y 
V. Comisión de Honor y Justicia, al órgano encargado de velar por el debido cumplimiento del 
presente reglamento. 
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Artículo 5.- Corresponde al Técnico Académico responsable de laboratorio, la coordinación de las 
actividades referentes al uso y cuidado que debe observarse en los laboratorios del “ECITEC.” 

CAPITULO II 

PROCEDIMIENTO PARA EL USO Y CUIDADO DE LOS LABORATORIOS 
Artículo 6.- La entrada de los alumnos a los laboratorios será con previa programación y horarios 
destinados para su uso. 
Artículo 7.- El alumno solo podrá acceder a los laboratorios bajo la supervisión y autorización del 
profesor de la materia. 
Artículo 8.- El alumno deberá registrarse para ingresar a los laboratorios, previo registro y credencial 
vigente legible sin enmendaduras y que lo acredite como alumno del “ECITEC”. 
Artículo 9.- El plantel no se hace responsable de robo, daños o percances ocasionados al material 
introducido por el alumno o profesor y que sea utilizado para la elaboración de proyectos de los alumnos 
por lo que se atenderá lo siguiente: 
a) El material podrá permanecer en el Taller por un lapso no mayor a dos semanas, después de 
haber sido presentado en su materia. 
b) Si se requiere mayor tiempo de permanencia, deberá ser autorizado por Administración, 
notificando a la Subdirección Académica. 
c) De no cumplirse lo anterior, el material se dispondrá fuera del área de trabajo sin responsabilidad 
para “ECITEC”. 
Artículo 10.- Dentro de los laboratorios los docentes y los alumnos, deberán usar el equipo de 
seguridad adecuado para el trabajo o práctica que desempeñaran, siendo el profesor a cargo del grupo 
el indicado para supervisar que los alumnos cumplan con ello. 
Artículo 11.- El préstamo de material, equipo y herramienta deberá realizarse conforme a la política de 
préstamos de la ECITEC. 
Artículo 12.- Cualquier trabajo que se realice dentro de los laboratorios deberá ser supervisado por el 
profesor responsable de la materia. 
Artículo 13.- Es responsabilidad del grupo y/o usuario(s), el dejar limpio y en buenas condiciones de 
uso, las instalaciones (y espacios utilizados durante la práctica) y (así como disponer para del) material 
que sea utilizado en cualquiera de los distintos laboratorios. 
Artículo 14.- Los alumnos que hagan mal uso, en forma parcial o total el equipo y mobiliario de los 
laboratorios, serán sujetos a la sanción que establezca la Dirección. 
Artículo 15.- El equipo y herramientas sólo deberán ser utilizados en el interior de las áreas destinadas 
para su uso. Tratándose de alguna actividad fuera del Taller o Laboratorio, deberá ser autorizado por 
la Administración. 
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Artículo 16.- Queda prohibido el uso de herramienta y/o equipos de laboratorio para realizar trabajos 
que diferentes a aquellos para los que están destinados. 
Artículo 17.- Es responsabilidad del usuario, los residuos generados en sus prácticas, conforme a la 
“Ley General para la prevención y gestión integral de los residuos”. Se deberá reportar al Técnico 
Académico para su correcta disposición. 

 

CAPITULO III 
 

DERECHOS DE LOS USUARIOS 
Artículo 18.- Son los derechos de los usuarios: 
I. Tener acceso a los laboratorios el día y hora, para realizar prácticas en las asignaturas que así lo 
requiera, conforme a los horarios oficiales, o previa calendarización y/o agenda de su uso. El docente 
requerirá previa identificación. 
II. Obtener el préstamo interno del material de laboratorio necesario para realizar sus prácticas, dentro 
de los primeros 15 minutos de clase, previa identificación con credencial legible y vigente de la 
“ECITEC”, acorde a stock de materiales. 
III. Recibir por parte del Técnico Académico la orientación e información sobre el adecuado uso de los 
laboratorios. 

 
CAPITULO IV 

 
OBLIGACIONES DE LOS USUARIOS 
Artículo 19.- Las obligaciones de los usuarios son: 
I. Cumplir con todo lo establecido en el presente Reglamento; 
II. Abstenerse de dañar parcial o totalmente el mobiliario, así como de los materiales y equipo del 
laboratorio. 
III. Usar e identificar el equipo de seguridad adecuado para el trabajo o práctica que desempeñen (No 
proporcionado por la Universidad). 
IV. Conducirse con respeto hacia el personal administrativo, académico y estudiantil de los 
laboratorios; 
V. Desarrollar todas y cada una de las actividades de prácticas, dentro del área del laboratorio 
previamente asignada por el programa educativo respectivo. 
VI. Cuidar el mobiliario de los talleres y/o laboratorios, previamente asignada por el Programa 
educativo respectivo. 
VII. Hacer uso del mobiliario y equipo únicamente para los fines académicos enmarcados por el 
“ECITEC”. 
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VIII. Por estatuto escolar se tiene tolerancia de 10 minutos para registrar su acceso así mismo 
registrar salida de los laboratorios al término del uso. 
IX. Resarcir daños causados al patrimonio de “ECITEC” de los que resultaren responsables siempre y 
cuando así lo determine la administración y subdirección académica. 
X. Abstenerse de fumar en el interior de los laboratorios. 
XI. Abstenerse de introducir alimentos, así como cualquier tipo de bebida al interior de las 
instalaciones; 
XII. Abstenerse de dejar basura en el interior de los laboratorios; 
XIII. Para el préstamo de materiales y equipo, se deberá referir a las políticas de préstamo; 
XIV. Abstenerse de sacar o introducir a los laboratorios, cualquier tipo de material sin previa 
autorización del responsable; 
XV. Abstenerse de operar cualquier máquina o equipo sin autorización y supervisión del docente o del 
responsable de los laboratorios y/o talleres; 
XVI. Reportar inmediatamente cualquier accidente de trabajo ocurrido en los laboratorios y/o talleres; 
XVII. Abstenerse de permanecer, dentro de los laboratorios fuera de los horarios asignados para sus 
respectivas prácticas, sin previa autorización. 
XVIII. Llenar la bitácora de uso diario del equipo con todos los datos solicitados en el formato. 
XIX. Para hacer uso de los laboratorios y/o talleres es necesario estar dado de alta en el seguro 
facultativo y presentar el comprobante de la vacuna de tétanos, cuando se le requiera. 
XX. Revisar la máquina y/o equipo antes y después de su uso, para asegurarse que se encuentra en 
condiciones óptimas de funcionamiento. 
XXI. Activar ante el IMSS su seguro facultativo, para tener acceso a los laboratorios y talleres de 
“ECITEC”. Es responsabilidad del docente verificar que el estudiante bajo su cargo tenga activo el 
seguro facultativo y en el caso que corresponda comprobar que tenga la vacuna del tétanos con los 
refuerzos. 

 
CAPÍTULO V 

 
REGLAS DE SEGURIDAD 
Artículo 20.- El alumno, desde el momento mismo que ingrese a las instalaciones de los laboratorios 
o talleres, deberá observar la seguridad en las instalaciones, debiendo actuar con cautela y prudencia 
en el manejo de los aparatos e instrumentos que utilice para sus prácticas, tomando en consideración 
que por su propia naturaleza resulta de peligro utilizarlos en forma indebida. Así mismo deberá 
identificar las rutas y salidas de evacuación. 
Artículo 21.- Los usuarios deberán utilizar el uniforme, pantalón, zapato cerrado y accesorios de 
seguridad que correspondan acorde a la NOM-017-STPS-2008. 
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Artículo 22.- En las prácticas que se utilicen sustancias químicas, deberán tomarse las medidas de 
seguridad pertinentes, que serán evaluadas por el profesor responsable. 
Artículo 23.- Cualquier problema identificado en el laboratorio o taller, deberá ser notificado 
inmediatamente al profesor titular de la materia y/o al Técnico Académico. 

 

CAPÍTULO VI 
 

SANCIONES 
Sin menoscabo de las sanciones previstas por otros ordenamientos, los usuarios de los laboratorios 
y/o talleres, serán responsables por el incumplimiento de las presentes disposiciones, y serán 
sancionados de conformidad a lo establecido por el artículo 26 del presente Reglamento, mismas que 
podrán ser aplicadas en forma individual o colectiva. 
Artículo 24.- A los usuarios que infrinjan las disposiciones del presente Reglamento podrán ser sujetos 
a las siguientes sanciones, de conformidad con la gravedad de la falta Sic. Artículo 126 & 127 del 
estatuto escolar: 
I. Amonestación verbal; 
II. Amonestación por escrito; III. Reposición; 
IV. Suspensión de los derechos de usuario; y 
V. Suspensión de los derechos académicos. 
Artículo 25.- A los usuarios que infrinjan alguna de las obligaciones señaladas en el Artículo 21 del 
presente Reglamento se harán acreedores a las sanciones siguientes: 
I. Amonestación verbal, a las conductas señaladas en las fracciones I, III, V; VII, VIII, X y XVII; 
II. Amonestación por escrito con copia a su expediente, a las conductas señaladas en las fracciones 
XIII, XIV y XV; 
III. Reposición, a las conductas señaladas en las fracciones II y VII 
Observando lo siguiente: 
a). En caso de pérdida, destrucción total o parcial de mobiliario el alumno deberá reponer dicho material 
en un término no mayor de quince días naturales improrrogables o bien cuando se trate de material 
deberá reponerlo por otro similar; tratándose de materiales discontinuados o especiales, se tendrá que 
pagar el costo adicional por la dificultad que genere su reposición a los laboratorios de “ECITEC”. 
IV. Suspensión de los Derechos de usuario, a las conductas señaladas en las fracciones II VII y XV II 
observando lo siguiente: 
a) Cuando se trate de material dañado a partir de la fecha de la sanción, que concluirá cuando el 
material dañado sea repuesto por el usuario. 
V. Suspensión de los Derechos Académicos, a las conductas señaladas en las fracciones II, XI XII y 
XV observando lo siguiente: 
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a) Será suspendido seis meses en sus derechos académicos a partir de la comisión de la falta, a partir 
del inicio o término del siguiente semestre. 
Artículo 26.- Al finalizar cada semestre los Técnicos Académicos responsables de Talleres enviará a 
la Administración el listado de alumnos, académicos y otros usuarios que incumplan las condiciones de 
préstamo, con copia al expediente académico del alumno moroso, para que se le impongan las 
sanciones previstas en este Reglamento. 
Artículo 27.- A los empleados académicos y administrativos, que incurran en alguna de las faltas 
mencionadas en estas disposiciones, se les aplicarán las sanciones o medidas disciplinarias que 
procedan de acuerdo con la Ley del Trabajo de los Servidores Públicos del Estado y Municipios y la 
Ley de Responsabilidades de los Servidores Públicos del Estado y Municipios. 
Artículo 28.- Las sanciones se impondrán tomando en consideración las condiciones personales y los 
antecedentes del infractor, las circunstancias en que se cometió la falta y la gravedad de esta. 
Artículo 29.- En todos los casos de responsabilidad relacionada con el uso de laboratorios, se otorgará 
al responsable de garantía de audiencia, ante la autoridad universitaria correspondiente. 

 
TRANSITORIOS 

 
ARTÍCULO PRIMERO. - El Presente Reglamento entrará en vigor a partir del periodo escolar 2018-2. 
Se publicará a través del órgano informativo interno del “ECITEC”. 
ARTÍCULO SEGUNDO. - Las situaciones no previstas en este Reglamento serán resueltas por la 

Dirección de “ECITEC”.
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PRÁCTICA 1. ANÁLISIS DE UN MARCO DE VIGAS 2D POR MÉTODO 
DE RIGIDEZ. 

 
 

1. Objetivo 
Comparar los resultados numéricos, así como para el análisis experimental, para determinar y validar la 
deformación de la estructura tipo marco estructural, así como los esfuerzos y fuerzas de reacción que se 
generan. Las herramientas para el desarrollo de la práctica es el software ANSYS y el software MATLAB, 
así como un marco de pruebas para validar los resultados teóricos, experimental y numérico. 

 
2. Alcance 

Este ejercicio tiene como finalidad analizar, comparar y validar un marco de vigas de sección uniforme 
con cargas puntuales mediante el uso de tres métodos: simulación (ANSYS), análisis numérico 
(MATLAB) y experimentalmente, para analizar los desplazamientos axiales, angulares, esfuerzos y 
reacciones cuando se someten a cargas y momentos. 

 
 

3. Definiciones 
 
ANSYS, Inc. es un software de simulación ingenieril. Está desarrollado para funcionar bajo la teoría de 
elemento finito para estructuras y volúmenes finitos para fluidos. MATLAB es un sistema de cómputo numérico 
que ofrece un entorno de desarrollo integrado (IDE) con un lenguaje de programación propio (lenguaje M). El 
método del elemento finito (MEF en español o FEM en inglés) es un método numérico para la resolución de 
ecuaciones diferenciales, utilizado en diversos problemas de ingeniería y física. [1]  
 
El método se basa en dividir el cuerpo, estructura o dominio (medio continuo) sobre el que están definidas 
ciertas ecuaciones integrales que caracterizan el comportamiento físico del problema, en una serie de 
subdominios no intersectantes entre sí denominados elementos finitos.  
 
El conjunto de elementos finitos forma una partición del dominio también llamada discretización. [1] 
 
La formulación de la matriz de rigidez del elemento de la viga se extiende a dos dimensiones. Esto implica 
dos desplazamientos axiales y un desplazamiento angular en cada nodo. Se supone que el elemento de viga 
es recto, de longitud L y con sección transversal constante. 
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Figure 1. Cargas y momento en los nodos. 

 
La relación del elemento se describe en un sistema de coordenadas de ejes principales (x, y, z) con origen en 
la sección final izquierda y el eje x colocado a lo largo de los centros de flexión de las secciones transversales. 

 
Figura 2.  TQ SRT20 Bending Moments In A Portal Frame 

4. Responsabilidades. 
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El profesor entregara a los estudiantes los materiales y conocimientos básicos de ANSYS para la realización 
de la práctica. 

 
A) Kit de llaves tipo Allen Tubo de Pitot. 
B) Kit de pesas (200, 500 y 1000 g)  
C) Mitutoyo Absolute Digimatic Indicator (ADI) 
D) TQ SRT20 Bending Moments In A Portal Frame 
E) Hardware (Computadora) 
F) Software (Ansys Workbench) 
G) Software (MATLAB) 

 
El alumno se presentará al laboratorio de manera puntual y portando: 

 
a) Bata de laboratorio. 
b) Zapatos de seguridad. 
c) Vale de solicitud de material. 
d) Practica de laboratorio. 
e) Laptop con programa de análisis estadístico. 
f) Cronometro. 
g) Marcador color negro. 

 
 
 

5. Procedimiento 
1) En la parte de simulación en ANSYS de la practica esta lo siguiente: 

 
1. Para realizar la simulación, comenzamos por abrir una pestaña “Static Structural”. 
2. Para abrir el Design Modeler hacer doble clic en “Geometry”. 
3. La figura se construye a partir de puntos, se selecciona “Point” en las baras superiores de la ventana Design 
Modeler. 
4. En el recuadro “Details” seleccionar Definition > Manueal Input. 
5. Ingresar las coordenadas (X, Y) del punto. 
6. Repetir los dos pasos anteriores con todos los puntos. 
7. Para unir los puntos con una línea seleccionar Concept > Lines From Points. 
8. Para asignar sección transversal, seleccionar Concept > Cross Section > Rectangular. 
9. Definimos la altura como 0.019 m y la base como 0.0032 m. 
10. En la ventana Details de la línea Line Body, seleccionamos en Cross Section la sección que acabamos de 
crear. 
11. Una vez generada la estructura, cerramos DesignModeler y abrimos Mechanic, haciendo doble clic en 
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Model, en la pestaña Static Structural de la ventana principal.. 
12. Primero, clic derecho Mesh > Generate Mesh. 
13. En Static Structural, seleccionamos el primer y último nodo, clic derecho > Insert > Fixed Support. 
14. De igual manera, seleccionamos uno de los 21 nodos libres e insertamos fuerzas y momentos. 
15. Para definir la fuerza, en la ventana Details, seleccionamos Define By > Components. Ingresamos los 
componentes X y Y de la fuerza en el nodo. 
16. Repetir para todas las fuerzas que se deseen ingresar. 
17. Como trabajamos en el eje XY, el momento se encontrará alrededor del eje Z. 
18. Una vez definidas las fuerzas y momentos, vamos a Solution (A6), seleccionamos el nodo que se desee 
medir, clic derecho > Insert > Directional Deformation. 
19. Ahora definimos la orientación (deformación en X o en Y). 
20. Para las reacciones, en Solution (A6) seleccionamos el nodo, clic derecho > Insert > Probe > Force 
Reaction/Moment Reaction. 
21. Para medir desplazamiento angular, seleccionar el nodo deseado, clic derecho en Model (A4) > Insert > 
Remote Point. 
22. Clic derecho en el Remote Point creado > Commands. 
23. En la ventana de commands escribimos NOMBRE DE LA VARIABLE = _npilot. 
24. Clic derecho Solution (A6) > Insert > Commands. 
25. En la ventana de commandos escribimos las siguientes funciones. NOMBRE DE LA VARIABLE se coloca 
dentro de los paréntesis. 
26. Clic en Solve. 
 
 

2) En la parte del análisis experimental esta los siguientes pasos: 
 

1. Identificar en que nodos se quiere realizar el análisis de desplazamientos. 
2. Colocar en posición la herramienta ADI. 
3. Una vez colocado, debemos asegurar que el dispositivo ADI se encuentre en contacto con la estructura 

TQ SRT20. 
4. Para usar el dispositivo ADI: 

a) Encender presionando el botón ON/OFF. 
b) Para calibrar el origen presionamos el botón ORIGIN, deberá darnos un valor inicial igual a cero. 
c) Para cambiar unidad de medida presionar el botón in/mm que nos permite trabajar en pulgadas o 
milímetros. 

5. Colocar las pesas. Usaremos los 3 sujetadores que posee el TQ SRT20. 
6. Una vez realizado los pasos anteriores el dispositivo ADI nos mostrará el desplazamiento en el nodo 

que se ha seleccionado. 
 

 



 

 

  
UNIVERSIDAD AUTÓNOMA DE BAJA CALIFORNIA 

FACULTAD DE CIENCIAS DE LA INGENIERÍA Y 
TECNOLOGÍA 

UNIDAD VALLE DE LAS PALMAS 

 
CÓDIGO: SG-PE-IAE 

 
PROGRAMA EDUCATIVO DE INGENIERIA AEROESPACIAL 

 
REVISIÓN No. 1 

 
MANUAL DE PRÁCTICAS DEL LABORATORIO 

 
PAGINA 1 / 15 

Realizado por 
FCITEC. 

Coordinado por 
Dr. Oscar Adrián Morales Contreras. 

Aprobado por 
M. I. Antonio Gómez Roa 

Función 
Departamento de mantenimiento. 

Función 
Coordinador de Ing. Aeroespacial. 

Función 
Director 

Pasos para realizar en el caso de necesitar analizar los nodos verticales: 
 
1. Desmontar la estructura con ayuda de las llaves Allen y sacar el dispositivo ADI. 
2. De la misma manera que retiramos el dispositivo ADI lo colocamos en los rieles de la barra vertical 

(izquierda o derecha), y volvemos a armarla estructura. 
3. Repetir el procedimiento para analizar el nuevo nodo. 

 

3) En la parte de análisis numérico se utiliza los siguientes pasos: 

 

1. Al iniciar el programa se mostrará un cuadro de dialogo donde se ingresarán los nodos donde se 
aplicará alguna carga o momento en el formato requerido. 

2. Se desplegará la siguiente interfaz gráfica. 

3. En la sección superior izquierda se encuentra el módulo de ingreso de datos. Donde el en la etiqueta 
superior se muestran los nodos seleccionados por el usuario. 

4. En la etiqueta central de muestran las instrucciones que debe seguir el usuario para ingresar datos en 
el nodo indicado. 

5. En las cajas editables se deben ingresar los valores para las cargas verticales (N), horizontales(N) y 
momento (N*m) de nodo indicado en la etiqueta central. 

6. Después de ingresar los datos en las cajas editables el usuario debe presionar el botón “Siguiente 
nodo” para continuar con el segundo nodo seleccionado. 

7. Al presionar el botón “Siguiente nodo” los datos ingresados se agregarán a la tabla. 

8. Se debe repetir los mismos pasos para los siguientes nodos. 

9. Una vez completo el ingreso de datos el módulo de ingreso de datos se bloqueará y se procederá al 
ingreso de propiedades de la sección transversal del marco. 

10. La propiedad para ingresar son las siguientes: 

 E = Modulo de elasticidad (Pa). 

Ancho = Base de la sección transversal (m). 

 L=Altura de la sección transversal (m). 

Una vez ingresadas las fuerzas y propiedades se debe presionar el botón calcular. 

12. Se desplegará un gráfico del banco donde se representan las fuerzas ingresadas. 

13. En la tabla “Deformaciones y rotaciones” se mostrarán los desplazamientos en x, y rotacionales en 
el siguiente formato. 
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1: Desplazamiento en x del nodo 2 

2: Desplazamiento en y del nodo2 

3: Rotacional del nodo 2 

4: Desplazamiento en x del nodo 3 

5: Desplazamiento en x del nodo 3 

6: Rotacional del nodo 3 

7: Desplazamiento en x del nodo 4 

8: Desplazamiento en y del nodo4 

9: Rotacional del nodo 4... 

(Así hasta el nodo 22.) 

 

14. En la sección “Esfuerzos” se muestra la lista de los 22 esfuerzos calculados, siendo el primer valor el 
esfuerzo del elemento 1 (Nodo 1 a Nodo 2), el segundo valor el esfuerzo del elemento 2 (Nodo 2 a Nodo 3) 
y así sucesivamente. 

 

Aplicando las metodologías definidas anteriormente, se validaron los nodos 3, 10 y 20 de la simulación (2, 
7 y 14 de marco de vigas). Las cargas de 0.2, 0.5 y 1 kg respectivamente por lo que obtuvimos los siguientes 
resultados, los errores máximos mayores a 2% se vieron únicamente en comparación con los resultados 
experimentales. Esto puede ser por varias razones, incluyendo el calibrado de las herramientas, las 
propiedades exactas del material e incluso la capacidad del instrumento de medición para mostrar más 
decimales. 

 

Resultados de desplazamientos en metros y rotacionales en radianes. 
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La conclusión fue en primera instancia se hizo uso del método de rigidez matricial de forma teórica para 
obtener la matriz global del marco de vigas, posteriormente se utilizó el software MATLAB para programar 
una interfaz gráfica que calculara los desplazamientos axiales y angulares (rotacionales). 
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